Getting Started.............................................................................................................................. 1
Credit Union Online........................................................................................................................ 1
Call Report Pro & Call Report Pro CU .......................................................................................... 1
Symitar System Files ...................................................................................................................... 1
Episys Extract Files ........................................................................................................................ 1
Cruise Extract Files ....................................................................................................................... 5
Installing DataLink CU .................................................................................................................. 6
System Requirements ..................................................................................................................... 6
Setup Procedures ........................................................................................................................... 6
Updating DataLink CU .................................................................................................................. 7
Opening and Closing DataLink CU ............................................................................................... 7
Menus and Tools Reference........................................................................................................... 8
Menus ............................................................................................................................................ 8
Toolbar Icons ................................................................................................................................ 9
Using DataLink CU .......................................................................................................................... 10
Forms ........................................................................................................................................... 10
Creating a Form ............................................................................................................................. 10
Modifying your Institution’s Information ....................................................................................... 10
Password Protecting your Form Data ........................................................................................... 11
Assigning Users Form Access ...................................................................................................... 11
Opening an Existing Form ........................................................................................................... 12
Deleting Form Data ...................................................................................................................... 12
Backing Up Form Data ................................................................................................................ 12
Restoring Form Data ................................................................................................................... 12
Importing Data Files ..................................................................................................................... 13
Extract Files ................................................................................................................................... 13
Delimited Files ............................................................................................................................ 13
Prior Quarter Data Files .............................................................................................................. 15
Viewing Account Data .................................................................................................................. 15
Working with Data ........................................................................................................................ 15
Create Data Conditions ............................................................................................................... 15
Create Data Filters ...................................................................................................................... 17
Mapping Data .............................................................................................................................. 19
Update Account Values ............................................................................................................... 23
Validating Your Data .................................................................................................................... 23
DataLink CU Reports .................................................................................................................... 24
Creating Reports ........................................................................................................................... 24
Viewing and Printing Reports ...................................................................................................... 24
Completing the NCUA 5300 Call Report ..................................................................................... 25
Submitting Data with DataLink CU .............................................................................................. 25
Transferring Data to Call Report Pro CU ....................................................................................... 26
Completing the FFIEC Call Report ................................................................................................ 26
Contacting Technical Support .................................................................................................... 26
Getting Started

Before you can begin working in DataLink CU each quarter, you must:

- Be set up to use the NCUA’s Credit Union Online website (Credit Unions only),
- Install your Jack Henry Call Report Pro software (Banks only),
- Create Symitar’s Episys or Cruise Extract files.

Credit Union Online

Credit Union Online is the NCUA’s web-based system used to collect and disseminate 5300 Call Report information. NCUA requires all online filing credit unions to submit their data through the online system. The NCUA administers the distribution of user names, passwords, and user roles for this system.

To access their website:

1. Open an Internet browser and go to http://www.ncua.gov
2. At the top of the NCUA’s home page, scroll over Regulation & Supervision and then select Regulatory Reporting.
3. Select Credit Union Online, and click the GO TO CREDIT UNION ONLINE NOW button.
4. Type in your User Name and Password, and click Login.
5. Follow any additional steps required by the NCUA to prepare for your Call Report filing.

Note

For further information on how to use the Credit Union Online website, please contact NCUA Technical Support by email at csdesk@ncua.gov or by phone at 1-800-827-3255.

Call Report Pro & Call Report Pro CU

Call Report Pro is the software that banks using DataLink CU will use to transfer their data for transmission to the FDIC’s Central Data Repository (CDR). Call Report Pro CU is a complementary program designed for credit unions, which integrates with DataLink CU. It contains supplemental features such as the NCUA edit checks, NCUA line item instructions, notes capability, analytical reports, the ability to submit data to the NCUA, and more. Please contact the Regulatory Filing group by e-mail RFGSupport@jackhenry.com or by phone at 1-800-688-9191 for questions about or assistance with these programs.

Symitar System Files

Extract files containing your credit union’s or bank’s quarterly data need to be downloaded from Symitar’s Episys or Cruise systems before you can import them into DataLink CU.

Episys Extract Files

To produce the files that DataLink CU requires, Episys extracts use the Miscellaneous Processing batch program and PowerOn specfiles developed especially for DataLink CU.
Episys Database Extract

The first step is to create the extract files using the Episys Data Base Extract from Miscellaneous Processing. You will need to create two separate jobs: one for Member Data and one for GL Data.

The following prompts must be answered as indicated:

- Database Type: Select (2) SQL Server BCP
- Table Consolidation: Select (0) Separate Table for Each Record Type
- Extract Comma Delimiter: Select (0) Comma
- Character Data Format: Select (0) Do not use Quotes around Data (BCP)
- Money Data Format: Select (1) Decimal point format
- FTP Format: Select (0) Prepare for Binary Mode FTP Transfer of Extracts
- Select Destination Directory: Select (1) /SYM/SYMXXX/SQLEXTRACT (XXX represents the directory from which the data is being extracted) (e.g., SYM 000)
- Select Destination Subdirectory: Enter the name of the directory where you want to store the extracted information (e.g., Member Database – DL.MEMBER.EXTRACT, GL Database – DL.GL.EXTRACT)
- Server Name (Take Default)
- Database Name (Take Default)
- Username (Take Default)
- Password (Take Default)
- PC Directory for Extracted Files (Take Default)
- PC Directory for Command Files (Take Default)
- Produce Initial Create Macro: Select No
- Produce Release Update Macros: Select No

When Episys prompts for which records to include in the extract, select those records you want included as a data source for your NCUA Call Report by answering “Yes” (answer “No” at the prompts of records that you do not want to include). Symitar suggests including the following records:

- Account
- Savings
- Loan
- Tracking
- Saving Tracking
- Loan Tracking
- GL Account
- GL Tracking

Notes:
- A separate job file should be run for GL data after all adjusting GL entries have been completed.
- GL Tracking must be completed prior to running the Episys Database Extract – GL Database Extract.
GL Database Extract

Create GL Tracking Type and define GL tracking record fields **(one time)**:
- Define a GL Tracking Record in GL Tracking Type Parameters
  - Description = DataLink GL Tracking
  - User Character 01 = 14-digit GL Account Number
  - User Amount 01 = Balance
  - User Amount 02 = Income/Expense YTD

Create and populate the GL tracking records with GL data **(once each quarter)**:
- Create a job file running PowerOn, specfile DL.GLTRACKING.FM
  - Select GL Month Choice (depending on whether target month is open or closed), or prompt for
  - Enter the appropriate Tracking Type #
- Create a job file running Misc Processing, Perform FM from PowerOn Output, GL Account, Report Title: DL.GLTRACKING.FM

Produce the GL database extract:
- Create a job file running Misc Processing, Episys Database Extract program
  - Answer the prompts as described under "[Symitar's Episys Extract File]"
- Nest these 3 job files and place in the SYMWIN.INI job file drop down, or instruct IT to run on specific schedule

PC Transfer
The second step is to PC Transfer files to the directory/folder where you want the extracted information to reside.
- From PC Transfer (Host System) select: Extract Files
- Locate the subdirectory where the extracted information was stored
- Highlight all files except SYMLOAD.BAT
- Click and drag the highlighted files to the directory created in the local system
- If there is an option to transfer as “Binary” or “Text”, select “Text”
**NCUA Reports**

Use NCUA Reports, from Miscellaneous Processing, in conjunction with the specfile RB.INSURABLE.SHARES.DF, to provide the data for the *Insurable Shares* section of the NCUA 5300 Call Report.

**From Miscellaneous Processing:**

- Select: (19) NCUA Reports
- NCUA Reports: Share Insurance Report
- Report Title: NCUA Share Insurance
- Number of Options: as desired, default is set to 1
- Category Type: 0-7, as desired
- List of Account Types: as desired (must replace the default value of NONE)
- List of Share Types: as desired (must replace the default value of NONE)
- List of IRS Codes to Include: as desired (must replace the default value of NONE)
- Category Description: accept default (which is the selection from Category type)
- Insurance Limit: as desired
- Use Beneficiary Percentages (if displayed): user defined
- List of Beneficiary Name Subtypes (if displayed): user defined

**RB.INSURABLE.SHARES.DF**

This PowerOn specfile converts the Insurable Shares Report to a data file that can be read by the DataLink CU application. The data output file produced by this specfile will need to be PC transferred to DataLink CU.

**From Batch Control:**

- Select: PowerOn
- At the Specfile prompt: Enter: RB.INSURABLE.SHARES.DF
- At the Default = System Date prompt enter: the report date from the print queue for the NCUA Share Insurance report.
- At the Default = NCUA Share Insurance Report prompt, enter the Report Title or Report Sequence number. (Found in Print Control)
- At the next Specification File prompt, press enter or click next.

This specfile creates two files: the Insurable Shares Datafile Data report is the one that should be PC transferred to DataLink CU. The other report Insurable Shares Datafile can be used by the credit union as a reference file.

**RB.NCUA.CALL.REPORT.EXT**

This specfile creates a report and an ASCII data file with all of the information from the 5300 NCUA Call Report Parameters. This can be used if the credit union is currently utilizing the Episys 5300 Call Report feature.

To create, from PC Transfer click on the reports folder. Locate the ASCII data file for RB.NCUA.CALL.REPORT.EXT, click on the report, and then drag it to the local system (e.g., to your Desktop). This report will be used only once.
The output of this file, once downloaded into DataLink CU, will automatically create the conditions, filters and mapping of the information currently contained in the parameters.

**Cruise Extract Files**

To produce the files that DataLink CU requires, the OEXPFS Executive task must be run. The description for this task is “Data Extract: ProfitStar”. Once the task is executed, four separate files will be generated for: Shares, Certificates, Loans, and General Ledger. The files will be placed in the directory specified in the task setup screen.
Installing DataLink CU

DataLink CU is an interface tool that allows extract files containing data from Symitar’s Episys or Cruise systems to be imported, mapped to NCUA (National Credit Union Administration) 5300 Call Report line items, and uploaded into the NCUA 5300 Call Report web-based application, for faster, easier reporting. Additionally, the tool can be used to map and prepare bank data to complete FFIEC Call Reports with the Jack Henry Call Report Pro software.

System Requirements

The following hardware and software is required to run DataLink CU:

- An IBM® or compatible PC running Windows® Vista, 7, 8.1, or 10 (32-bit or 64-bit)
- .NET Framework 3.5 (SP 1)
- Microsoft SQL Server Compact 4.0
- Adobe® Reader
- An Internet connection
- Monitor set to 800x600 pixels and Normal fonts (96 dpi) (minimum)

Tip: To change your monitor settings, navigate to the Control Panel, and then click the Display icon. Changing monitor settings will vary slightly different depending on the operating system that you are using.

Setup Procedures

1. If your DataLink CU is on CD-ROM, insert the disc into your CD-ROM drive. If the CD does not auto run, you will need to start the installation manually. To do this, access Windows Explorer and navigate to your CD-ROM drive. Double-click the file DataLinkCU.exe. Click OK, and skip to step 3.

2. If you download the DataLink CU executable file from our website, double-click this file to begin the installation.

Note

DataLink CU requires both .NET 3.5 and Microsoft SQL CE 4.0. A check is run during the installation process to verify that these programs are on your computer. If either one of these components are not found, the program will prompt you to install them automatically. If necessary, follow the on screen prompts to install these programs.

3. When the Welcome to the DataLink CU Installation Wizard dialog box appears, click Next.

4. In the Destination Folder dialog box, verify that the program directory will be installed to your desired location. Then, click Next. To change the folder, click Browse and select a new location.

Note

DataLink CU is designed to be installed on your local C: drive. However, you may share the application by installing it on the local C: drives of other PCs and placing the data directory on a shared network drive.

Once you have installed the program, you can point to the data directory on the network by using Settings on the DataLink CU home screen.
5. Click **Next** to install the application.
6. Click **Finish** to exit the installation.

### Updating DataLink CU

If you are connected to the Internet at the computer where your DataLink CU is installed, you will be automatically notified and prompted to download any updates to enhance or correct issues in the program.

Alternately, you can click **Update** on the DataLink CU home screen to check for recent updates to or messages about the software.

- If there is an *update* available for download, an update dialog box will appear. To download and install the update, click **Continue**. The program will automatically close, and the update will download and install. DataLink CU will restart after the update is applied.
- If there is a *message* available for you to view, a message dialog box will appear. After reading the message, click **Acknowledge**. The message will display every time you check for updates or messages unless the “Do not display this message again” checkbox is checked. Click **Print** to print the message.

### Opening and Closing DataLink CU

**To open the program:**

On your Desktop, double-click the DataLink CU icon, or click **Start > Programs > Jack Henry > DataLink > DataLink CU**

**To close the program:**

1. Click the **System Close Button** or **Exit** on the DataLink CU home screen, or **File > Exit** from within the software.
2. If you are using DataLink CU, and want to return to the home screen, click **Forms** or **File > Close** from within the software.
Menus and Tools Reference

The software provides both a Menu bar and Toolbar icons, allowing easy access to DataLink CU functionality.

The menu bar
A. File  B. Tools  C. Help

Menus

A. File

File

Save
Save an open Call Report.

Close
Closes an open Call Report, and returns you to the DataLink CU home screen.

Institution Information
Use to display or edit your institution’s information entered when creating a new Call Report.

Exit
Close the DataLink CU program.

B. Tools

Tools

Find Line Item
Jump to any Line Item in the Mapping area by simply typing in its account number and letting DataLink CU search through the schedules for you.

Calculator
Opens the calculator tool for easy reference.

Manage Import Data
Use this option to free up hard drive space by deleting unused data import files.

C. Help

Help

Forms and Instructions
View the Call Report forms and instructions.

Product Manual
Reference the DataLink CU Software Guide.

About
Current release information.
Toolbar Icons

Forms
Displays the DataLink CU home screen where you can open, delete, or create a new 5300 or FFIEC Call Report. Additionally, you can modify directory settings, check for program updates, and backup and restore data from this screen.

Import Files
Select to add or delete import files.

Accounts
Select to view the data contained in any imported files.

Conditions
Select to create, edit, or delete data conditions.

Filters
Select to create, edit, or delete data filters.

Mapping
Use this view to map filters and manually entered values to line items in the Call Report.

Reports
Create reports for verification, analysis, or record keeping purposes.

Upload
Create a file to upload to the NCUA’s Credit Union Online web-based application for the 5300 Call Report, or create a transfer file for the Call Report Pro or Call Report Pro CU software.

Help
Program help is available to guide you through the use of DataLink CU.
Using DataLink CU
Once you have created your Episys or Cruise extract files, you are ready to begin your work in DataLink CU.

DataLink CU incorporates the following easy-to-follow steps for compiling and mapping your credit union’s data:
- Forms
- Import Files
- Accounts
- Conditions
- Filters
- Mappings

Forms
On the DataLink CU home screen, you can create a new form, or open or delete existing forms. You can also modify your data directory settings, run program updates, and backup and/or restore data from this screen.

To return to the DataLink CU home screen from within the software, click the Forms icon on the toolbar.

Creating a Form
Before you can begin the mapping process, a quarterly form must be created in DataLink CU.

1. Once you open the DataLink CU program, by default you will be on the DataLink CU home screen. To begin, click New.
2. Input, or select, the Institution’s ID (e.g., CU Charter #, Bank ID RSSD #), Name, and Type.
3. Click Finished to create the form.

   You will now see the newly created record on the DataLink CU home screen.

Tip: On the DataLink CU home screen, you can sort your filings by Name, ID #, or Quarter by clicking on the desired column heading.

Modifying your Institution’s Information
To view or change information previously entered when creating a form, follow these steps:

1. In an open form, click File > Institution Information.
2. Make any modifications, as needed.
3. Click Finished.
Password Protecting your Form Data

You can protect the privacy of your data by enabling password-protection. This will grant only users with the password access to the form.

To assign a password:
1. In an open form, click **File > Form Security**.
2. In the **Form Password** area, type in the “Password” text box a password you want to use to password-protect your form.
3. Press the Tab key, or click the “Confirm Password” text box, and then re-type your password to ensure accuracy.
4. Make a note of your password, and when you’re satisfied with your choice, click **Finished**.

**Notes:**
- To change your password, simply type over the old password with your new password, confirm your new password, and click **Finished**.
- To disable form security, delete your password (i.e., make blank), and click **Finished**.

Assigning Users Form Access

In addition to password protection, users can be granted access to the specific schedules for which they need access. The person who creates the form for the quarter will be the de facto administrator (e.g., Form Creator\Owner) and can grant form access to other users. Additionally, the administrator will have access to all schedules in the form, by default. *If you elect to use this feature, you must add all users who require access to the form.*

To grant a user access:
1. In the **User Access** area, type in the user’s “Login Name” (e.g., their computer login name), and click the **+** button.
2. With the name of the user’s login name highlighted, click the appropriate check boxes in the “Schedule Access” area to grant the user access to the schedules they are allowed to modify.
3. Repeat the process, as needed, for each user.
4. When complete, click **Finished**.

**Notes:**
- To give another user the ability to access and make changes in the **Form Security** area, check the **Allow Form Security Access** check box. This will grant the selected user administrative privileges in the **Form Security** area.
- To remove a user from having form access, click to highlight their “Login Name” and click the **-** button.
Opening an Existing Form
Opening an existing form is required whenever returning to complete or review a Call Report.

1. Once you open the DataLink CU program, by default you will be on the DataLink CU home screen.
2. Click to highlight the form you want to open in the grid, and click Open.
   
   You will now be able to continue working on the conditions, filters, mapping, etc. for this institution.

Deleting Form Data
Deleting old or unwanted Call Reports from DataLink CU is easy, and will help you organize your records more efficiently.

1. Once you open the DataLink CU program, by default you will be on the DataLink CU home screen.
2. Click to highlight the form you want to delete in the grid, and click Delete.
3. Click Yes to verify that you want to delete the form data for the selected institution.

Backing Up Form Data
Periodically backing up your work helps prevent unfortunate data loss. Using the DataLink CU backup selection will help you save your work in case of a hardware failure, and is easy to use. We recommend that you keep a copy of your backup data file on a network drive that is periodically backed up.

1. Once you open the DataLink CU program, by default you will be on the DataLink CU home screen.
2. Click to highlight the form whose data you want to backup in the grid, and click Backup.
3. Follow the onscreen instructions to select the location where you would like to store your backup files.

Note
In addition to the option of manually backing up your data (described above), DataLink CU automatically backs up your data every hour and saves it to your Backup directory.

Restoring Form Data
Restoring previously backed up copies of your DataLink CU data is effortless with DataLink CU. The program will automatically display the “Manual” backup files you have saved to your Backup directory, making data restoration easy.

1. On the DataLink CU home screen, click Restore.
2. Click to highlight the backup file you want to restore in the grid, and click Restore.

Tip: To display and/or restore “Automatic” backup files, which have been saved periodically by DataLink CU, click the corresponding checkbox next to Show Backups of Type.
Importing Data Files

Once a form for the current quarter is created, you are able to import several types of data files into DataLink CU for mapping purposes. Additionally, Credit Union users can import prior quarter data files (*.xml) downloaded from the NCUA Credit Union Online website, which will display in the Mappings area, providing you an easy way to compare your current data to what you filed last quarter.

Currently, users can import the following file types:

- Episys Member Data Extract (EDBE Process)
- Episys GL Data Extract (EDBE Process)
- Episys Insurable Share Report (Specfile)
- Episys NCUA Parameter File, if applicable (Specfile) – This file contains any mappings already established in the system and only needs to be imported the first time you use DataLink CU. It is listed as “Symitar Episys One Time Import”.
- Cruise Extract
- Third party delimited files, optional
- Prior Quarter Data files, optional

Extract Files

1. In DataLink CU, click the Import Files icon on the toolbar.
2. In the Files area, click Add.
3. Click the drop-down arrow to select your “File Type”.
4. Click Browse to locate your extract directory (e.g., “Episys Extract”) and click OK.
5. Type a “Description” for your file (optional), and click Next.
6. Once the file extract has processed, click Done. Your data is now available to create conditions and filters for mapping to Call Report line items.

Note
For Episys Member Data and GL Data files, you have the option to “Select Fields to Import”. If you click this check box, you can select the specific fields that you would like to import for each record within these extract file(s).

Delimited Files

1. In DataLink CU, click the Import Files icon on the toolbar.
2. Under the Files option, click Add.
3. Click the drop-down arrow next to “File Type” to select Delimited.
4. Click Browse to locate and select your file, then click Open.
5. Type a “Description” for your file (optional), and click Next.
6. At the bottom of the File Preview area, select the appropriate “Delimiter” for your file.

7. Next, select the “Text Qualifier” for your file.

8. In the Rows area, select the row containing your “Field Names”, if applicable. Your field names will then automatically populate in the grid. Next, select the “Import Start” row if you have a row containing field names at the beginning of your file. For example, if the first row in your file contains your column names, you would select “1” as your “Field Names” row and “2” as your “Import Start” row.

9. In the Fields area, click Edit to complete the file definition process. Confirm the “Data Type” for each column in your file to ensure that it imports successfully. Click Save to apply your changes.

Tip: You can also double-click on the column headers (i.e., “Field 1”, “Field 2”, etc.) to access the Import Fields dialog box and input your column names and select their data types.

Notes:
- When defining a “Date Time” data type in the Date Time Format area, it is imperative to use the correct abbreviations, which are case-sensitive, and to exactly input them to match the data contained in your file. Please refer to the Importing Data Files (Delimited Files) help topic by clicking the Help button on the Import Fields box, or the icon on your toolbar, for more information.
- When mapping an import file based on “Line Item ID” (e.g., “730A” in the NCUA 5300), conditions and filters will be automatically generated and mapped to the corresponding line item. If selecting this method, you must use “Line Item Value” (not “Value”) to define the value column in your import file. Additionally, we recommend that you keep the checkbox “For a Line Item ID import, do not sum duplicate references” checked. This will prevent the possible doubling of values, should your file repeat any line item IDs.

10. Once you have finished defining your file, click the drop-down arrow next to Finish and select Save & Import.

11. Once the file has imported, click Done.

Tip: For Extract and Delimited file imports, refer to Update Account Values on page 23 to review the options for updating the values of your mapped line items.
Prior Quarter Data Files

1. In DataLink CU, click the **Import Files** icon on the toolbar.
2. Under the **Files** option, click **Add**.
3. Click the drop-down arrow next to “File Type” to select **Prior Quarter Data**.
4. Click **Browse** to locate and select your file (e.g., Charter # _Quarter-Year.xml), then click **Open**.
5. Type a “Description” for your file (optional), and click **Finished**.
6. Click **OK**. Your prior quarter data will now be displayed in the **Prior Quarter Submission** field for each line item in the Mappings area of the software.

**Notes:**
- Prior Call Reports can be downloaded from the **Call Report** tab on the NCUA’s website. Click the **XML** button next to the cycle date, and select to **Save** your data file.
- To delete an import a file you no longer need, click to select it, and then click **Delete** in the **Files** area.
- Importing prior quarter data files is **optional**, but must be done every quarter if you want to view this data.

Viewing Account Data

Once you have imported data files, you can view your data for verification purposes, etc.

To access, click the **Accounts** icon on the toolbar.

1. Under **Accounts**, click the drop-down arrow and select the **File\Extract** that contains the data that you would like to view.
2. Next, select the **Record** in which the data is located. The contents of the table will then be displayed in the bottom portion of the pane.

Working with Data

The credit union data contained in the extract files is separated into records and is in a “raw” format. In order to make the data usable for NCUA 5300 or FFIEC Call Report purposes, users must define conditions, and then filters, in DataLink CU to run against the data records contained in the files. The filters created can then be used to map data to the line items in the Call Report form.

*Conditions* and *Filters* can be created by clicking those respective icons on the toolbar and following the instructions below, or they can be created in the **Mapping** area by clicking the **Mapping Wizard** icon and advancing through the screens. (See the **Mapping Wizard** section on page 20 for further instructions).

Create Data Conditions

In order to break out data and organize it into the groupings needed for 5300 or FFIEC Call Report purposes, users must first create conditions in DataLink CU.
1. To begin, click the **Conditions** icon on the toolbar.

2. In the **Conditions** area, click **New Condition**. Select **Blank** to begin a brand new condition, or select **Inherit Selected** to copy from another condition that contains the same basic elements (data source, query components, etc.) to save time.

**Step 1: Identify Data Source**

3. Under **Data Source**, click the drop-down arrow and select your **File\Extract**.

4. Next, select the **Record** (e.g., Loan) for which you would like to create a data condition.

**Step 2: Define Query**

You can select to run a query on your selected record, or select all accounts in the record. If doing the former:

5. Click the drop-down arrow and select the **Field** (e.g., Type) in the record required to create your data condition.

6. Next, select the **Operator** (e.g., Equal) needed to arrive at the data you need.

7. Finally, **Select or Enter**, if not present, the **Value** (e.g., 10) needed for your condition. Alternately, you can use the **Date Calculation** button and **Edit Calculation**, if appropriate. This option is available when a date field is selected (e.g., Due Date). A “Date Calculation” is a date value that is calculated the specified number of days, months or years from the quarter-end. The result is updated each quarter as the quarter-end date changes.

**Note**
The **Selection** (e.g., LOAN) for Step 2 will populate based on the **Record** selected in Step 1.

**Step 3: Test your Condition**

8. You can verify the number of accounts matching your query, by clicking **Get Count** under **Condition Result**. Click **View Accounts...** for more information on the accounts meeting your condition. Click **Export**, if desired, to save this data.

**Step 4: Name and Save your Condition**

9. In the **ID** area, input a unique **Name**, **Description**, and **Group** for your condition (optional). If nothing is entered, the first two fields will be generated for you.

10. Click **Save**.
11. Repeat the above Steps 1 through 4, as needed, to create all of the conditions you will need to manipulate your data for NCUA 5300 or FFIEC Call Report preparation purposes.

Notes:
- To modify a previously created condition, click to select it, and then click Edit.
- To delete a condition you no longer need, click to select it, and then click Delete.
- To delete all of your conditions, click Delete All. **WARNING**: Performing this selection will also delete ALL filters and clear ALL mappings. Use with caution.

Tips:
1. On the main Conditions page, you can quickly go to a Filter or Line Item utilizing a specific condition by selecting it in the grid and using your right-click menu.
2. You can sort your conditions by clicking on the desired column heading: Name, Description, Group, Filters or Line Items.

Create Data Filters
Once you have created the conditions necessary to organize your data, you will use one or more conditions to create data filters. These filters are what you will ultimately use to map data to NCUA 5300 or FFIEC Call Report line items.

1. To begin, click the Filters icon on the toolbar.
2. In the Filters area, click New Filter. Select Blank to begin a brand new filter, or select Inherit Selected to copy from another filter that contains the same basic elements (data source, conditions, etc.) to save time.

Step 1: Identify Data Source
3. Under Data Source, click the drop-down arrow and select your File/Extract.
4. Next, select the Record (e.g., Loan) for which you would like to create a data filter.

Note
You must select the Data Source that matches the condition(s) you assign to the filter.

Step 2: Select Value Field(s)
5. Click the drop-down arrow and select the numeric field(s) containing the values you need to be summed or averaged (e.g., Balance), and then click Add.

Select the Count button only when you want to return the number of accounts matching your condition(s).
Step 3: Select Condition(s)

6. Click **Edit**, under **Condition(s)**, to select the condition(s) that you need to include in your data filter.

7. Click to highlight a condition that you would like to use in your filter, and then click **Add Condition**. If needed, repeat to include all of the necessary conditions for your filter.

**Notes:**
- Use the **Add, Subtract, Sum, and Average** selections to indicate how you need to handle the data meeting your condition:
  - (+): Default setting; fields will be added together to arrive at the total value.
  - (-): Use to subtract a field value from the total value.
  - SUM: Default setting; field values obtained as a result of the criteria will be summed.
  - AVG: The field values obtained as a result of the query will be averaged together.
- To delete a field you no longer need, click to select it, and then click **Delete**.

8. Once your filter condition selections are complete, click **Save**.

**Notes:**
- When creating a filter containing more than one condition, select a **Join** operator and then click **Add**.
  - **AND** – Use to combine conditions where the data must completely match all criteria. This will create a more specific, limited set of data.
  - **OR** – Use to combine conditions that are more sweeping in scope. This will create a broader set of data.
- If needed, click (+) to separate or combine multiple conditions with parenthesis.
- To delete a condition within a filter, click to select it, and then click **Delete Selected**.
- To delete all of the conditions within a filter, click **Clear All**.
Step 4: Name your Filter

9. Input a Name, Description, and Group for your filter (optional). If nothing is entered, the program will generate the first two fields for you.

Step 5: Test and Save your Filter

10. To verify that your filter yields the desired amount, click Value: under Result. Click View... for more information on the accounts included in your filter. Click Export, if desired, to save this data.

11. Once your filter is complete, click Save.

12. Repeat the above Steps 1 through 5, as needed, to create all of the filters needed to map data to NCUA 5300 or FFIEC Call Report line items.

Notes:

- To modify a previously created filter, click to select it, and then click Edit.
- To delete a filter you no longer need, click to select it, and then click Delete. To delete all of your filters, click Delete All. **WARNING**: Performing the latter selection will also clear ALL mappings.

Tips:

(1) On the main Filters page, you can quickly go to a Line Item utilizing a specific filter or Map a filter by selecting it in the grid and using your right-click menu.

(2) You can sort your filters by clicking on the desired column heading: Name, Description, Group, Value or Line Items.

Mapping Data

You can now begin mapping the filters you’ve created in the Conditions and Filters areas of the program to NCUA 5300 or FFIEC Call Report line items. Alternately, if no filter exists for a particular line item, you can manually enter its value.

If you have elected to use the Mapping Wizard, mapping is automatically done through this utility. Click the icon in the Selected Form Item section to get started (See Mapping Wizard section below for further instructions.)

Using Filters

Use the data filters you have created to map data to NCUA 5300 or FFIEC Call Report line items.

1. To begin, click the Mapping icon on the toolbar.

2. Under Form Items, click the “+” next to the Page/Schedule in the NCUA 5300 or FFIEC Call Report form where you would like to map data.

3. Click on the specific Call Report line item that you would like to map data to.

4. Click Select Filters.

5. In the Filters area, check the data filter(s) that you want to map to the selected line item.
6. When finished, click **Save**.

7. Repeat this process for all Call Report line items for which you have created data filters and would like to map the available data.

💡 **Tips:**

(1) In the *Form Items* area, items listed in **bold green** indicate that changes were made to that page’s/schedule’s line items for the current quarter. Details of the specific line item change are available in the *Selected Form Item* area.

(2) In the *Selected Form item* area, you can click the hyperlinked “Description” (e.g., **Cash on Hand (Coin and Currency)**) to view the NCUA’s instructions for the selected line item. Additionally, you can add instructional or other “Notes” for each line item, if desired. *These do not transmit with your report.*

### Manually Enter Values

If no filter exists for a line item, you can simply input its value for inclusion in your 5300 or FFIEC Call Report. To later view only line items with manually entered values, click the “View Only Items with Manual Values” check box in the *Form Items* area.

**To manually enter values:**

1. Follow steps 1 through 3 above.
2. Click **Manual Values**.
3. Click **New**.
4. Type in a Name, Description and Value.
5. Click **Save**.

**Notes:**

- To edit a mapped filter’s value or a manually entered value, click on the filter in the *Selected Form Item* grid to highlight it, and then click **Edit +/- %**. You can modify the value’s positive/negative status, the percent of the value to map, etc. Click **Save** once editing is complete.

- Select **Clear Mappings**, under *Form Items*, if you would like to clear the mappings for all line items. This selection should be used with caution!

- In the *Selected Form Item* area, the **Prior Quarter Submission** field displays data that you can import in order to compare current data to prior quarter data (see page 14).

### Mapping Wizard

The **Mapping Wizard** utility allows you to create one or more conditions, a filter, and then map your filter to the selected Call Report line item **automatically** by advancing through six simplified screens. These screens closely resemble the functionality found in the separate *Conditions* and *Filters* areas of the software. (See **Create Data Conditions** and **Create Data Filters** sections on pages 15 and 17, respectively, for further information.)

To begin, in the **Mapping** area select the form line item you want to map data for and click the **Mapping Wizard** icon 🔄. Advance through the screens below to complete the process.
Screen 1: Identify Data Source for New Condition

Screen 2: Create Query for New Condition

Screen 3: Name your Condition

Use the **Range** checkbox to map a range of accounts to a line item.
Screen 4: Select Condition(s) to Create Filter

Notes:
- Select <Edit> to return to the “Condition Selection” screen to make modifications to a condition, if needed.
- Click the <Add New> button to return to the “Condition Selection” screen to create another condition, if desired. Select Blank to create a brand new condition, or Inherit Selected to copy information from this condition to create a new condition.

Screen 5: Select Filter Value to Map to Line Item

Screen 6: Name your Filter

Click Finished when your work in the Mapping Wizard is complete for the selected line item. Repeat the process, as needed, to complete mapping for all desired line items.
**Update Account Values**

Updating values runs the filters and conditions you have created in order to update the filter values shown in the *Selected Form Item* area. You can update or refresh values for individual filters, line items, or update the values for all line items that you have mapped filters for in DataLink CU.

**Updating Individual Filter Values**

To update *only* the value for the selected filter in the *Selected Form Item* grid, click **Update Value**.

**Updating Individual Line Item Values**

To update *only* the values for the selected line item visible in the *Selected Form Item* area, click **Update Values**.

**Updating All Account Values**

To update the values for *all* line items mapped in DataLink CU, click **Update Form Values** in the *Form Items* area.

**Validating Your Data**

The NCUA’s error checks are not included in DataLink CU, however, they are available in our complementary Call Report Pro CU software. If you are *not* using this software, you will see your edit failures once your data once it is uploaded on the NCUA’s Credit Union Online website. There, you will be given the opportunity to correct your data before submission. For a more seamless filing process, we recommend that you verify the figures extracted from your core system for accuracy *before* submitting your data on the NCUA’s website.

There are several reports available on your core system that can be used to validate your data before submitting it to the NCUA. These include, but are not limited to:

- Balance Sheet
- Income Statement
- Member Trial Balance
- Share and Loan Balancing Report
- Delinquency Report (e.g., make sure that set up for DataLink DQ is similar to the Episys DQ Report—If Episys report is using “days”, then DataLink should also calculate DQ by days.)

Identifying and correcting potential data problems ahead of time will result in better record keeping within the DataLink CU system, more accurate reports, and fewer issues when submitting your NCUA 5300 Call Report.
DataLink CU Reports

The DataLink CU Reports feature presents several reports selections for your analysis and record keeping.

- **NCUA Call Report** – A presentation of your credit union’s mapped values in the 5300 Call Report form.
- **FFIEC Call Report** – A presentation of your bank’s mapped values in the FFIEC Call Report form.
- **Line Item Audit Trail** – A comprehensive report detailing the values for each Call Report line item, displaying the queries and summing information of the Filters and Conditions utilized at the individual line item level.
- **Line Item Audit Trail – Separate Detail** – A streamlined report detailing all values for each Call Report line item, with the Filters and Conditions utilized displayed separately at the end of the report.
- **Line Item Audit Trail – Manual Values Only** – A detailed report including only the manually entered amounts mapped to individual Call Report line items.

Creating Reports

1. Click the **Reports** icon on the toolbar.
2. Under **New Reports**, click the drop-down arrow to select the report you want.
3. Click **Create**.

A report, in PDF format, will be generated and listed in the **Reports** area. Additionally, it will be saved to your ...\JackHenry\DataLink\Reports directory.

Viewing and Printing Reports

4. Under **Reports**, select the report you want to view and click **Open**.
5. To print the report, click the icon or **File > Print** from within Adobe Reader.

Notes:

- To delete a report that you no longer need, select it in the **Reports** area and click **Delete**.
- To access the reports that have been saved to your **Reports** directory, click in the **Reports** area.
Completing the NCUA 5300 Call Report

After you have completed the mapping process and have verified your data, you are ready to create an upload file in DataLink CU and upload it to the Credit Union Online web-based application for the NCUA 5300 Call Report. Alternately, those that also use Call Report Pro CU can create a file to transfer their data and complete the filing it that software.

Submitting Data with DataLink CU

To create and upload your file:

1. In DataLink CU, click the Upload icon on the toolbar.
2. In the Upload/Transfer Options area, click Create Upload File.
3. Answer “Yes” or “No” to indicate whether you wish to update your filter values before creating your upload file.
4. Note the path to which your upload file was saved, then click OK.
5. An Internet browser will open, taking you to the NCUA CU Online Login dialog box. Type in your User Name and Password, and click Login. (See page 1 for further information.)
6. Click on the “CALL REPORT” tab.
7. Click on the Cycle Date for which you want to import a file.
8. Click the Import Call Report button.
9. Browse for and select the upload file (e.g., 201512.xml) you created. (If needed, return to DataLink CU and click Open Upload Directory to locate your file.)
10. Click Save, and then OK to confirm the import.
11. Once your data is imported, you must correct any Errors and/or comment on any Warnings or Historical Warnings, and complete any remaining data items on the online system.
12. After your data is complete and verified, submit your 5300 Call Report per the NCUA’s instructions. The Instruction Guide can be found on the NCUA’s website (http://www.ncua.gov/DataApps/Documents/CUOInstructions.pdf) in the “Credit Union Online Help” area (refer to pages 18 - 19, Submit Your 5300 Call Report).
13. To close DataLink CU, click File > Exit.

Notes:

- On the 1st day of each Call Report cycle, all credit unions that are required to report will have a “pending” Call Report for that cycle available on the NCUA’s system (i.e., January 1st, April 1st, July 1st, and October 1st). You do not need to “start” your Call Report.
- An import file (*.xml) can be imported into the NCUA system for pending Call Reports only. Whenever an import is done, all account values in the file will overwrite the corresponding values in the pending Call Report. For example, if the import file only contains values for ten accounts, only these ten will be overwritten in the pending Call Report.
- In the NCUA system, all cells must have a value, even if that value is zero.
Transferring Data to Call Report Pro CU

To create a transfer file:

1. In DataLink CU, click the Upload icon on the toolbar.
2. In the Upload/Transfer Options area, click Transfer to Call Report Pro CU.
3. Once the file is saved, click OK.
4. Install Call Report Pro CU and set up a current quarter credit union record. When prompted that a new DataLink transfer is available, click Yes to import your data.
5. Click Transfer Now, and then Close when complete.

For further information on how to use Call Report Pro CU and complete your Call Report filing, please access that program’s manual from within the software (Help > Product Manual).

Completing the FFIEC Call Report

After you have completed the mapping process and have verified your data, you are ready to create an upload file and transfer your data into the Jack Henry Call Report Pro software for FFIEC Call Report preparation.

To create and upload your file:

1. In DataLink CU, click the Upload icon on the toolbar.
2. In the Transfer to Call Report Pro Options area, click the Transfer button.
3. Answer “Yes” or “No” when prompted to update your filter values before transferring your data.
4. Click OK. Your data will be loaded into the Call Report Pro DataLink tool and will be available to you the next time you open that software.

For further information on how to use Call Report Pro DataLink and complete your Call Report filing, please access that program’s manual from within the software (Help > Product Manual).

Contacting Technical Support

For technical support regarding the DataLink CU program or Episys extract files and data contained in them, please contact the Symitar GL group at 1-888-SYMITAR (press 1, 1, 1, 5) between 8:00 a.m. and 5:00 p.m. Pacific Standard Time, Monday through Friday.

For questions regarding Cruise extract files and data, please call 1-888-796-4827 (x305900) between 8:00 a.m. and 5:00 p.m. Eastern Standard Time, Monday through Friday.

For emergency after hours support, please contact the Jack Henry & Associates Call Center at 1-800-299-4222, and request that a case be set up for you to receive support from the Symitar GL or Cruise groups.